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Data Quality · Forecasting · Dashboards

MODULE 2 — DATA ANALYTICS

Clean data. Precise forecast. Live AI Dashboard.

3-5 Hours Individual Coaching Live Demo & Exercises
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Note:

This training is conducted by an AI system as the trainer (e.g., ChatGPT, Gemini, Claude) – upload both Markdown files 
(SystemPrompt.md and Content.md), then type "Start". No human trainer is required.

Download both files: https://www.foundic.org/category/courses/

https://www.foundic.org
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1 Upload Files to Chat

① Open Your LLM in Browser
ChatGPT, Claude, or Gemini — Text Mode (no Audio)

② Upload Both Markdown Files
systemprompt.md + content.md via Drag & Drop

✕ Do NOT Upload the PowerPoint
Only the two .md files belong in the chat

No Audio Yet — Upload Files in Text Mode Only

Files Missing? Download: foundic.org/courses

2 Begin Training with "Start"

① Type the Word: start
One word is enough — trainer starts automatically

② Split Your Screen
Left: Chat window  ·  Right: Open PowerPoint slides

✓ Slides are your visual guide — trainer tells you when to 

advance

3 Optional: Enable Audio Mode

① Complete Steps 1 & 2 First
Upload files + type "start" — then enable audio

② Enable Audio Mode
ChatGPT: Headphone icon  ·  Gemini: Microphone icon

③ Put On Headset & Speak
View Slides, Speak Freely with Trainer

Available only in ChatGPT (Advanced Voice) and Gemini Live 

— not in Claude.

M2-02  | Training Setup: How to Start Your LLM-Moderated Training

https://www.foundic.org
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MODULE 2  ·  Opening M2-03  |  Transfer Check & Entry

Transfer Check Module 1 — What Have You Implemented?

Transfer Check Module 1

Which prompt did you use this week?

→ Please share briefly — 2 minutes

→ Celebrate success — then take the next step

What went well?

What time savings have you achieved?

→ Concrete number: "X minutes for Y task"

→ Record for quick-win plan

Entry Check Module 2

Where do you see data chaos in your finance work today?

→ I'm actively listening — share your concrete example

Your data problem today

Please answer briefly: Which data task

takes the most time per month? → We'll build the solution for it today.

Dataset Setup: Northern Light Corporation dataset.xlsx must be open — Please check now with me.

Module 2 starts today. We'll apply what we learn directly to your real dataset.
foundic.org
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MODULE 2  ·  Opening M2-04  |  Agenda — 2–4 Hours

Agenda — What to Expect Today
Transfer Check Module 1 + Entry Check Entry15 min

Input: The data problem behind every poor forecast Input10 min

ACCURATE framework: 8 data quality dimensions (Data Literacy) Input15 min

LIVE DEMO: PowerQuery — Clean & prepare ERP export Demo15 min

EXERCISE 1: PowerQuery Lab — Clean Northern Light dataset Exercise20 min

KPI_Dictionary: Build Once, Use Forever Input15 min

INDIVIDUAL CHECK: Your first KPI according to dictionary standard Check10 min

LEARNING CHECK 1 (6 Multiple-Choice) Check10 min

BREAK (Screen off) Pause10 min

Descriptive statistics for controllers: median, IQR Input15 min

Anomaly Detection: 3 Methods + Forensic Indicators Input15 min

DEMO+EXERCISE 2: Anomaly check Excel + AI Prompt Demo+Exercise20 min

Forecasting methods overview + Excel FORECAST.ETS Input20 min

Train/Test split, quality metrics (MAPE, MAE, RMSE) + confidence intervals Input15 min

LEARNING CHECK 2 (6 Multiple-Choice) Check10 min

BREAK (Screen off) Pause10 min

BUILDING SESSION: Management Dashboard + AI Commentary Hands-on30 min

Wrap-up: Key Takeaways · Transfer Task · Outlook Module 3 Wrap-up10 min
foundic.org
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MODULE 2  ·  Input M2-05  |  The Data Problem Behind Every Forecast

Why Do 70% of Forecasts Fail? — Not Because of the Model, 
Because of the Data.

Common Problems in Typical Finance Teams:

12 Excel versions

Monthly report exists in 12 different files. 
Which one is current?

3 EBIT definitions

Controlling, accounting, and management 
board each define EBIT differently.

Manual copying

4–8 hrs/month: ERP export → Excel → Pivot → 
PowerPoint.

The solution: Build a clean data pipeline once — then it runs continuously.

PowerQuery = automated cleaning, transforming, loading (ETL) — no code required

KPI_Dictionary = unified definitions for all departments

AI commentary = narrative output directly from clean data

Garbage in → Garbage out. Clean data is not an IT task — it's the controller's responsibility.
foundic.org
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MODULE 2  ·  Input M2-06  |  What Does This Deliver in Practice?

Efficiency Potential — Module 2: What You Save Today

The greatest leverage is not in better formulas — but in a clean data pipeline.
foundic.org
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Task Today With AI+Tools Savings/Month

Clean & prepare ERP export 4–8 hrs/month 0.5–1 hrs ~6 hrs/month

KPI calculation & consolidation 2–4 hrs/month 0.5 hrs ~3 hrs/month

Update forecast model 3–6 hrs/month 1 hr ~4 hrs/month

Dashboard commentary 2–3 hrs/month 0.25 hrs ~2.5 hrs/month

Manual anomaly detection 2–5 hrs/month 0.5 hrs ~4 hrs/month

∑ TOTAL (conservative) 13–26 hrs/month ~3 hrs/month ∼3–5 hrs/week

https://www.foundic.org
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MODULE 2  ·  Data Literacy M2-07  |  ACCURATE — 8 Quality Dimensions

ACCURATE: The 8 dimensions of data quality

A — Accuracy

Accuracy: Is booking amount correct?

C — Completeness

Completeness: Are Q3 entries missing?

C — Currency

Timeliness: Are these prior-year prices?

U — Uniqueness

Uniqueness: Are duplicates in journal?

R — Relevance

Relevance: Are all fields needed?

A — Authority

Authority: Source = ERP/GL?

T — Traceability

Traceability: Source to report path clear?

E — Ease-of-Use

Ease-of-Use: Ready to use directly?

ACCURATE quick check before every AI analysis: Are my data complete, current, and from the right source?
foundic.org
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MODULE 2  ·  PowerQuery M2-08  |  The ETL Turbo for Finance

PowerQuery — Extract, Transform, Load Without Code

EXTRACT

• Load data sources: Excel, CSV, SQL, SharePoint, 
SAP via OData

• Configure once → always repeatable

• Connection retained — no manual copying

TRANSFORM

• Split, Merge, Pivot/Unpivot, Group By, 
Conditional Columns

• Fix data types: Text to Number, correct date 
formats

• Remove duplicates, handle blanks, trim text

LOAD

• Into data model (PowerPivot) or directly into 
table

• Auto refresh — Power BI: scheduled refresh

• AI support: ChatGPT/Copilot generates M-
Code on request

PowerQuery replaces manual file edits. Built once — refreshed monthly with one click.
foundic.org
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MODULE 2  ·  PowerQuery M2-09  |  LIVE DEMO: Clean an ERP Export

LIVE DEMO: Open now Northern Light Corporation dataset.xlsx

Step-by-step: Northern Light Corporation export from raw to clean

1. Load Data → Get Data → From File → From Workbook. Select "Journal Entries" table. Query Editor opens.

2. Fix Data 
Types

Amount column: Replace thousands separator with comma. Data type: decimal number (European format)

3. Date "Posting date" column → Type: Date. Error rows: Remove errors.

4. Duplicates "Receipt ID" column → Remove duplicates. Result: X rows removed.

5. Load Close & Load. Clean table appears. Next time: click Refresh All.

Trainer Prompt (after demo): "Write me a PowerQuery M-code step

that removes all rows where the 'Amount' column is empty or null."

Every step in PowerQuery is reproducible and documented.
foundic.org

foundic.org

https://www.foundic.org
https://www.foundic.org


MODULE 2  ·  PowerQuery M2-10  |  EXERCISE 1: PowerQuery Lab

EXERCISE 1 (20 Min.) — You clean the Northern Light 
Corporation Dataset

Task: Clean Northern Light Corporation Dataset

1. Load the "Booking Journal" table into PowerQuery

2. Lock the data type of the Amount column (European decimal format)

3. Correct the date format of the "Booking Date" column

4. Remove duplicates via the "Receipt ID" column

5. Load the result as a clean table

6. BONUS: Have ChatGPT write filter M code

Reference Guide

Data → Get Data → From File

Select column → Change type

Home → Remove Duplicates

Close & Load

Error? Right-click → Remove Errors

Done? Take a screenshot!

Goal: You have a clean dataset in PowerQuery — ready for KPI calculations and Forecasting.
foundic.org
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MODULE 2  ·  KPI_Dictionary M2-11  |  Build Once, Use Forever

The KPI_Dictionary — End of Definition Wars

What belongs in a KPI_Dictionary?

KPI Name | Formula | Data Source | Responsible Party

Granularity (Month/Quarter) | Validation Rule | Version

Without Dictionary: EBIT Definitions in Practice

Controlling: EBIT Before Special Items

Accounting: EBIT per IFRS | Management: Adjusted EBIT

A KPI_Dictionary is not an IT project — it is an Excel sheet. One day setup, years of savings.
foundic.org
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KPI Field Example: EBIT Example: Contribution Margin

Definition Result before interest and taxes, after special items per IAS 1 Revenue minus variable costs per product/segment

Formula Revenue − COGS − Operating Expenses − D&A Revenue × Margin % per Item

Source SAP FI-GL, Company Code 1000 SAP CO-PA, Profit Center Extract

Responsible Head of Controlling FP&A-Team

Granularity Monthly, Group Level Monthly, Product Line

https://www.foundic.org
https://www.foundic.org


MODULE 2  ·  KPI_Dictionary M2-12  |  Individual Coaching Check: Your First KPI

Individual Coaching Check (10 Min.) — Define Your Most 
Important KPIs  

Task: Define ONE KPI from your daily work

Select your most important control KPI (e.g., EBIT, Contribution Margin, Cash Flow)

Answer: What exactly does it measure? How is it calculated?

Where does it come from? Who is responsible?

At what granularity is it needed?

BONUS: ChatGPT Prompt: "Create a KPI_Dictionary row for me for [KPI-Name] in a controlling context."

Finished Dictionary as download: Northern Light Corporation ROI Calculator Template.xlsx → Tab "KPI_Dictionary" — you can insert directly 

there.

A KPI without a dictionary entry is an opinion. With one, it is a control instrument.
foundic.org
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MODULE 2  ·  Learning Check 1 M2-13  |  Learning Check 1

Learning Check 1 — 6 questions | 1 correct answer each | Trainer discusses directly.

1. What does T mean in the ACCURATE framework?

A) Transparency

B) Transformability

C) Traceability — Auditability ✓

D) Timing

2. What is the first step in the ETL process?

A) Transform: Clean data

B) Extract: Load da ta from source

C) Load: Save result

D)  Audit: Check data

3. Which KPI_Dictionary field prevents definition conflicts?

A) KPI-Name

B) Granularity

C) Data Source

D) Formula + System of Record

4. PowerQuery stores steps as...?

A) VBA Macros

B) SQL Queries

C) Power Query M Steps

D)  Python Code

5. What is Completeness in ACCURATE?

A) No duplicates

B) No missing rows or fields

C) Current data

D) Correct data types

6. What GDPR obligation applies to AI tools for data analysis?

A) All data can be entered

B) Only aggregated, anonymized data without personal reference

C) Only internal tools permitted

D) Approval from Works Council always required

Learning Check 1 completed. Whoever gets all 6 correct: PowerQuery session will confirm you.
foundic.org
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PAUSE  |  M2-14

PAUSE
Screen off — stand up briefly — back in 10 minutes

After break: Descriptive Statistics — Identify outliers, detect anomalies

foundic.org
foundic.org
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MODULE 2  ·  Statistics M2-15  |  Descriptive Statistics for Controllers

Descriptive Statistics — Understand numbers instead of just 
trusting them

Mean vs. Median

Mean: susceptible to outliers.
Median: more robust for skewed data.
Finance: Median booking amount vs. average!

=AVERAGE(B2:B1000)

=MEDIAN(B2:B1000)

Standard Deviation

Measure of spread: How far are values from the 
mean?
Finance: Measure volatility of cost positions.
>2 standard deviations = outlier signal.

=STDEV(B2:B1000)

Outlier: |x-mean| > 2×STDEV

IQR Rule

Interquartile range: Q3 minus Q1.
Outlier: < Q1−1.5×IQR or > Q3+1.5×IQR.
Best practice for booking journals.

Q1=QUARTILE(B2:B1000,1)

Q3=QUARTILE(B2:B1000,3)

IQR=Q3-Q1

Median and IQR are more robust than mean and variance — especially for finance data with outliers.
foundic.org
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MODULE 2  ·  Statistics M2-16  |  Anomaly Detection: 3 Methods

Anomaly Detection — AI meets Controlling

1 Rule-Based

• Bookings outside business hours (22:00–
6:00)

• Transfers to unknown accounts

• Amounts above approval limit without 
authorization

Fast, transparent, explainable. Known patterns 
only.

2 IQR Outliers

• Amount < Q1 − 1.5×IQR or > Q3 + 1.5×IQR

• Round amounts: 10,000, 50,000, 100,000 
EUR exactly

• Duplicate bookings same 
amount+account+day

Statistically robust, no prior knowledge 
needed.

3 AI Prompt Analysis

• Pass aggregated flag list to ChatGPT

• Prompt: "Which patterns suggest errors?"

• → No personal reference — patterns and 
amounts only

Finds unknown patterns. Review obligation 
remains!

Combination of all 3 methods: Rule-based filters quickly, IQR finds outliers, AI detects unknown patterns.
foundic.org
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MODULE 2  ·  Statistics M2-17  |  DEMO+EXERCISE 2: Anomaly Check

DEMO+EXERCISE 2 (20 Min.) — Uncover Anomalies in the 
Northern Light Booking Journal.

Task: Anomaly Check in 3 Steps

1. Calculate IQR: QUARTILE(Amount,1) and QUARTILE(Amount,3)

2. Set outlier flag: IF(Amount > Q3+1.5*IQR; "FLAG"; "")

3. Filter round amounts: Amount = ROUND(Amount,-3)

4. Check timestamp: Bookings before 7 AM or after 9 PM?

5. BONUS: Flag list (amount+flag only) in ChatGPT: "Which patterns do you see?"

Expected Result

IQR outliers: 3–8 rows

Round amount flags: 2–5 rows

Night bookings: 1–3 rows

ChatGPT pattern: "Round-Number-Bias visible"

→ Checklist for accountants created

AI Prompt (Step 5): "I have an anonymized booking journal extract with amount and flag indicators.

What patterns suggest manual intervention or errors? Explain each notable point."

The result of this exercise is your personal anomaly checklist — ready for real use.
foundic.org
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MODULE 2  ·  Statistics M2-18  |  Forensic Indicators

Forensic Booking Audit — What AI and Excel Detect

Round Number Bias

Bookings in exact 1,000 or 10,000 amounts cluster. Signal for manual 
intervention or estimates.

Timing Anomalies

Bookings outside business hours, on weekends, or shortly before quarter-end.

Duplicates

Same amount + account + date twice. Often in manual corrections without 
reversal.

Benford's Law

First digit of booking amounts should follow Benford distribution (1 most 
frequent). Deviations = signal.

User Concentration

1 user ID books disproportionately many transfers or large amounts.

Missing Receipts

Bookings without receipt number or with generic text ("Other", 
"miscellaneous").

No single indicator proves fraud — but each combination significantly increases audit grounds.
foundic.org
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MODULE 2  ·  Forecasting M2-19  |  Forecasting Methods Overview

Forecasting Methods — Choosing the Right Approach Makes the 
Difference

Today's Focus: FORECAST.ETS (highlighted in purple) — the best balance between effort and accuracy for Finance Controllers.

Always Start with FORECAST.ETS — Simple, explainable, usable in Excel without IT support.
foundic.org
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Method When to Use? Tool Effort Accuracy

Moving Average Short-term, smooth trends Excel ★☆☆ Low

Trend Line (Linear Regression) Clear trend, 1 variable Excel / Power BI ★★☆ Medium

FORECAST.ETS (Holt-Winters) Seasonal data, >24 months Excel ★★★ Medium-High

Multiple Regression Multiple drivers known Excel / Python ★★★ Medium-High

Prophet (Meta/ML) Holidays/Events, large datasets Python in Excel / Azure ★★★ High

Copilot Narrative Forecast Commentary ChatGPT / Copilot for Finance ★☆☆ n/a (Text)

https://www.foundic.org
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MODULE 2  ·  Forecasting M2-20  |  LIVE DEMO: Revenue Forecast in Excel

LIVE DEMO (15 min.) — Revenue Forecast in Excel + AI 
Narrative for the CFO.

1. Data Time series: 24 months of monthly revenue from northern_light_corporation_dataset.xlsx. Column A: Date, Column B: Revenue.

2. Forecast =FORECAST.ETS(TargetDate; Values; Timeline; Season=12; Confidence=1). Fill formula for 12 months.

3. Confidence 
Band

=FORECAST.ETS.CONFINT(...;0.95) for upper and lower confidence band (95%). Chart: Line + Area.

4. AI Narrative Forecast table (without customer data) in ChatGPT: Prompt below → Explanation text in 3 paragraphs.

5. Embed Embed Narrative + Forecast Chart in Reporting Template. Review: Are the numbers plausible?

ChatGPT Prompt (Step 4): "You are a CFO advisor. Comment on this revenue forecast in 3 paragraphs:

1. Trend & Seasonality. 2. Greatest Risks/Uncertainties. 3. Recommendation for the Board.

Forecast Data: [Insert table]. Language: English, management-appropriate."

FORECAST.ETS + AI Narrative = professional Forecast Report in under 30 minutes.
foundic.org
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MODULE 2  ·  Forecasting M2-21  |  Train/Test-Split & Quality Metrics

How Good is My Forecast? — Backtesting and Quality Metrics

Backtest: Test model on past data

1. Hide last 6 months (reserve as test set)

2. Train model only on remaining 18 months

3. Calculate forecast for the 6 hidden months

4. Compare forecast vs. actual values

Why Backtest?

Model could fit perfectly on training data but fail on new data

Out-of-sample test shows true forecast quality

Min. 24 months of data recommended

Metric Formula (simplified) Assessment Finance Rule of Thumb

MAPE Ø |Actual−Forecast|/Actual × 100 Intuitive: % Error <5% very good | 5-15% acceptable

MAE Ø |Ist−Forecast| Same unit as KPI Easy to explain to CFO

RMSE √(Ø(Ist−Forecast)²) Penalizes outliers Important when extreme values are costly

Recommendation: MAPE for management communication, RMSE for technical model selection. Never show R² alone.

A forecast without quality metric is an opinion. With MAPE it becomes a measurable statement.
foundic.org
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MODULE 2  ·  Forecasting M2-22  |  Communicating Confidence Intervals Correctly

Confidence Interval — Range Instead of Point Value

What does the confidence interval say?

95% confidence band: With 95% probability, the true value lies within the 
band

Narrow band = more reliable model | Wide band = high uncertainty

Always communicate: "Forecast lies between X and Y"

What it DOES NOT say

Not a promise — 5% of cases fall outside

Seasonal peaks often break the band

External shocks (war, pandemic) not in the model

CFO Communication:
"Our forecast for Q4: 12.4 million – 14.1 million EUR (95% band). Mean: 13.2 million."

→ Board understands: There is uncertainty. The point forecast is not a promise.

Typical Mistake:
"Our forecast for Q4: 13.2 million EUR." (Without band)

→ Board thinks: This is a safe statement. Disappointments are pre-programmed.

Excel: =FORECAST.ETS.CONFINT(TargetDate; Values; Timeline; 0.95; 1; 1)  →  Returns HALF the band width. Forecast 

+/− CONFINT = upper/lower band.

Always communicate ranges, not points. This is professional and protects you.
foundic.org
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MODULE 2  ·  Analytics M2-23  |  Predictive vs. Prescriptive Analytics

Predictive vs. Prescriptive — Where is Your Finance Team?

Descriptive

Reporting

What happened?

Monthly report, variance analysis, 
dashboard

Diagnostic

Analysis

Why did it happen?

Root cause analysis, drill-down, AI-
prompt analysis

Predictive

Forecast

What will happen?

FORECAST.ETS, Regression, Prophet, 
Scenario

Prescriptive

Optimization

What should we do?

Optimization model, What-If 
analysis, AI recommendation

VALUE INCREASE → Higher maturity levels = greater business impact

Most finance teams are at Level 1–2. Level 3 (Predictive) is the realistic goal for this year.
foundic.org
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MODULE 2  ·  Learning Check 2 M2-24  |  Learning Status Check 2

Learning Status Check 2 — 6 Questions | 1 correct answer each | Trainer discusses directly.

1. What does MAPE measure in forecasting?

A) Model complexity

B) Average percentage error

C) Confidence band width

D) R² value

2. When should you use FORECAST.ETS?

A) Only for 100,000+ data points

B) For seasonal time series with >24 months

C) Only for non-seasonal data

D) Only in Power BI

3. What is IQR in anomaly detection?

A) Internal quality rating

B) Interquartile range: Q3 minus Q1

C) Index quality report

D)  Inflation quarterly response

4. What does prescriptive analytics mean?

A) Explains what happened

B) Predicts what will happen

C) Recommends what to do 

D)  Creates reports automatically

5. Which data must Bernd NOT enter into ChatGPT?

A) Aggregated monthly revenue without customer reference

B) Posting journal with employee names

C) FORECAST.ETS table with monthly data

D)  MAPE evaluation without personal reference

6. What does the 95% confidence band show in the forecast?

A) That 95% of forecasts are correct

B) That 95% of future values fall within the band 

C) The best and worst ca se scenario

D)  The error rate  of the model

F5 important: GDPR applies to AI tools too. Never share posting journals with personal data externally.
foundic.org
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PAUSE  |  M2-25

PAUSE
Screen off — stand up briefly — back in 10 minutes

After the break: Management Dashboard — IBCS Standard + Power BI Copilot

foundic.org
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MODULE 2  ·  Dashboard M2-26  |  IBCS — Management Dashboard Standards

Management Dashboard — IBCS Quick-Check

Consistent Colors

Actual=Dark, Budget=Gray, Prior Year=Light, Positive=Green, 
Negative=Red. No colorful chaos.

Bars Instead of Pie Charts

Pie charts prevent comparability. Bars allow direct size comparisons.

No Chart Junk

No 3D, no unnecessary gridlines, no shadows, no clip art.

Consistent Axes

Same scale for comparable charts. Start axis at 0 (Exception: explicitly 
marked).

AI Narrative

Automatic accompanying text explains the most important message of the 
chart in 1–2 sentences.

Sparklines

Compact mini-charts for time series in tables instead of bloated chart 
slides.

IBCS is not a style — it is a standard. Consistent dashboards reduce misunderstandings and revision rounds.
foundic.org
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MODULE 2  ·  Dashboard M2-27  |  Power BI Copilot: NLQ & Smart Narratives

Power BI Copilot — Ask AI questions directly to the dashboard

Natural Language Query (NLQ)

Enter free text directly in Power BI:

"Show me revenue by region for Q3 vs. prior year"

"Which cost center has the largest variance?"

→ Power BI automatically generates the appropriate visual

Smart Narratives

AI-generated text block directly in the report:

"Revenue increased by 8% YoY in Q3 — driven by..."

Automatically updated on data refresh

Basis for management comments and board slides

✓ Strengths

No export needed — AI runs directly on the data model

Model validation included (numbers are correct)

Integration with M365 Teams and SharePoint

Limitations

Model dependency: NLQ requires clean data model

Language quality varies and requires review.

Review Required — AI may misinterpret

EU AI Act Art. 4: AI literacy requirement applies to Power BI Copilot use in finance processes — subject to proof.

Power BI Copilot Doesn't Replace You — It Speeds You Up. Review Required, Always.
foundic.org
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MODULE 2  ·  Analytics M2-28  |  Your Data Maturity

Data Maturity Assessment — Where are you today?

1
Level 1: Excel-Silos

Everyone has their own file. No central model, no dictionary, manual consolidation.

You invest today ~10 hrs/month in data 
work.

2
Level 2: PowerQuery + Dictionary

Unified ETL pipeline, KPI_Dictionary available, data comes automatically.

~3-5 hrs/month data work. This is 
where Module 2 brings you.

3
Level 3: Self-Service BI

Power BI or Excel dashboard, forecast with FORECAST.ETS, AI narrative automated.

~1-2 hrs/month. Click reporting. AI 
writes commentary.

4
Level 4: AI-Powered Insights

Predictive + Prescriptive Analytics, anomaly detection automated, NLQ dashboard.

<1 hr/month data work. Finance team 
focused on decisions.

Goal after Module 2: Level 2 achieved. Goal by end of masterclass: Level 3. Level 4 possible in 6-12 months.
foundic.org
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MODULE 2  ·  Building Session M2-29  |  BUILDING SESSION: Management-Dashboard

BUILDING SESSION (30 Min.) — Today you build your own 
Management Dashboard with AI-commentary.
Your Task: Build Management Dashboard

STEP 1 (5 min.): PowerQuery query on cleaned dataset — load revenue by month

STEP 2 (8 min.): FORECAST.ETS for next 12 months + confidence band

STEP 3 (7 min.): IBCS-compliant chart: bars, correct colors, no 3D

STEP 4 (5 min.): Generate AI narrative (ChatGPT prompt from Slide 19)

STEP 5 (5 min.): Finalize dashboard + screenshot for your records

Target Output

• 1 IBCS chart (bar/line chart)

• Forecast Table (12 Months)

• Confidence band (95%)

• 3 paragraphs of AI narrative

• Ready for executive board

• Download: northern_light_corporation_dataset.xlsx

Template: northern_light_roi_calculator_template.xlsx → Tab "Dashboard-Template" — build directly there. All IBCS colors pre-configured.

Your dashboard today is not an exercise example — it is your first production-ready Finance-AI solution.
foundic.org
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MODULE 2  ·  Mini-Case M2-30  |  Mini-Case: CFO vs. Auditor

MINI-CASE (10 Min.) — “The CFO wants the AI forecast — the 
auditor asks for the model.”

CFO

controller, the forecast looks good. Can I present it like this?
AI created it? Perfect, then it must be correct.

What does the controller answer?

Auditor

Wait. What model underlies the forecast?
What assumptions? How was accuracy measured?
Without documentation, I cannot approve this.

What does the auditor need?

Sample solution: Model documentation (method, assumptions, MAPE, validation date) + note "AI-assisted review: B. Mayer 15.10.2024"

AI forecast without documentation is not a forecast. P-Q-R: Plausibility, Quality, Review — always.
foundic.org
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MODULE 2  ·  Closing Learning Check M2-31  |  Closing Learning Check

Closing Check: 6 questions — Module 2 complete. 1 correct answer each.

1. What are the 8 dimensions of ACCURATE?

A) Agile , Clean, Comprehensive...

B) Accuracy, Completeness, Currency, Uniqueness, Relevance, Authority, Traceability, Ease-of-Use ✓

C) Authenticity, Correctness, Clarity...

D)  ACCURA TE is not a Finance standard

2. Main advantage of PowerQuery vs. manual corrections?

A) Fa ster to write

B) No license required

C) Steps documented and repeatable

D) More functions than Excel

3. What method for seasonal forecasts in Excel?

A) Moving average

B) Linear regression

C) FORECAST.ETS (Holt-Winters seasonality)

D) Only Prophet/ML is precise

4. What does the confidence band correctly communicate?

A) The model's accuracy rate in %

B) The likely ra nge under model assumptions

C) The worst-case  value

D)  The average of all scenarios

5. What is forbidden in IBCS dashboards?

A) Using sparklines

B) Bars for time series

C) 3D Charts And Inconsistent Color Schemes

D) Embedding an AI Narrative

6. What is the P-Q-R rule for AI outputs?

A) Promote, Query, Review

B) Plausibility, Quality, Review — every AI output must be verified ✓

C) Predict, Quantify, Report

D) Parse, Query, Render

Module 2 completed. ACCURATE → PowerQuery → FORECAST.ETS → P-Q-R. This is your toolset.
foundic.org
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MODULE 2  ·  Closing M2-32 |  Key Takeaways

Key Takeaways — What You've Learned Today

ACCURATE is your quality radar

Before every AI analysis: Are my data complete, current, and from the right source? Garbage in = garbage out.

PowerQuery saves hours

Build once, one click every month. No more manual copying. ChatGPT writes the M-code.

KPI_Dictionary ends definition wars

One definition, one source, one responsible person. No more EBIT disputes in board meetings.

#️⃣
FORECAST.ETS for 90% of cases

Seasonal time series + 24 months of data = professional forecast in 15 minutes. Communicate with confidence band.

P-Q-R always applies

Plausibility, Quality, Review. Every AI output — whether forecast, narrative, or anomaly flag — must be reviewed by humans.

5 Takeaways. 1 Goal: Clean data → Right forecast → Convincing report. In under 30 minutes.
foundic.org

foundic.org

https://www.foundic.org
https://www.foundic.org


MODULE 2  ·  Closing M2-33  |  Transfer Task Until Module 3

Your Transfer Task — Until Module 3: Build a clean data 
pipeline .

Mandatory Task (30–60 min.)

1. Load your real ERP export into PowerQuery

2. Build 3 cleaning steps (data types, duplicates, empty cells)

3. Define 1 KPI in your dictionary (per template)

4. Screenshot of finished query — bring to Module 3

5. Note: How much time have you saved vs. manually?

Bonus (Optional)

Apply FORECAST.ETS to your own time series

Calculate MAPE (backtest)

Generate AI narrative

Show to your manager!

→ Extra points in Quick-Win Plan

The transfer task is not homework — it is your first step to Level 2 in your real company.
foundic.org
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Measure Tool Time Savings Quick-Win

PowerQuery pipeline Excel / Power BI ~5-6 hrs/month High ★★★

KPI_Dictionary Excel ~2-3 hrs/month Medium ★★☆

FORECAST.ETS + narrative Excel + ChatGPT ~3-4 hrs/month High ★★★
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MODULE 2 · Closing M2-34  |  All 5 Modules + Quick-Win Plan

Digital Finance Masterclass — Your Progress

The Masterclass Roadmap

1
Entry & Quick Wins

AI fundamentals, CRAFT, data privacy, custom GPT
Completed

2
Data Analytics

PowerQuery, KPI dictionary, forecasting, IBCS
Completed

3
Virtual Finance Team

agents, Make.com, guardrails, HITL
→ Next session

4
Accounting & Operations

RAG, AP automation, fraud detection, SoD
→ Follow-up session

5
Strategy & Governance

EU AI Act, ROI Calculator, Roadmap, Change
→ Closing

My Quick-Win Plan — Starting Tomorrow

1. My Task:

Select a concrete use case from Module 2 

2. My Power Query Step:

ERP export clean — one step today

3. My First KPI:

Define in Dictionary — Formula + Source

4. My Forecast Plan:

Apply FORECAST.ETS to your own time series

2 of 5 modules completed. Next Session: Virtual Finance Team
foundic.org
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Until Module 3: Transfer task implementation — PowerQuery pipeline and 1 KPI_Dictionary entry finalize.
foundic.org

Module 2 completed!

Data & Analytics — From data chaos to decision-ready insights

Module 3: Virtual Finance Team

AI workflow automation · multi-agent · E2E finance processes



MODULE 2  ·  Glossary M2-36  |  Glossary Module 2

Glossary — 12 Core Terms Module 2

ACCURATE:

Data quality framework: Accuracy, Completeness, Currency, Uniqueness, Relevance, 
Authority, Traceability, Ease-of-Use.

ETL:

Extract, Transform, Load — three-step data processing process. PowerQuery is the ETL tool 
for Finance.

PowerQuery:

Integrated Excel/Power BI tool for automated data transformation. Stores steps as Power 
Query M code.

KPI_Dictionary:

Documentation of all management KPIs: definition, formula, source, responsible owner, 
granularity.

IQR:

Interquartile range: Q3 minus Q1. Robust measure for outlier detection without sensitivity to 
extremes.

FORECAST.ETS:

Excel function for exponential smoothing (Holt-Winters). Automatically detects trend and 
seasonality.

MAPE:

Mean Absolute Percentage Error. Average percentage error. <5% very good, 5-15% 
acceptable.

Confidence interval:

Range in which the real value lies with X% probability. 95% band = standard communication.

Backtest:

Test model on historical data: hide last N months, calculate forecast, compare with actual.

IBCS:

International Business Communication Standards. Uniform rules for charts and dashboards in 
finance.

Smart Narrative:

AI-generated text block in dashboard. Automatically explains the most important message of 
the chart.

P-Q-R rule:

Plausibility, Quality, Review. Every AI output must be reviewed by humans. Documentation 
mandatory.

Glossary as backup slide — display directly when technical terms appear. Download in northern_light_corporation_dataset.xlsx.
foundic.org
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M2-37  |  Training Completion

You made it! 

Thank you for your time and trust.

I hope you've taken something away — and implement it tomorrow.
Suggestions for improvement? Leave a comment on foundic.org — we read every suggestion and continuously optimize our training.

Suggestions for improvement? Leave a comment on foundic.org — we read every suggestion and continuously optimize 
our training.

Our goal: Free training for everyone — because continuing education should not be a matter of budget.

If you enjoyed the training — buy us a coffee. It helps us develop more free training.

☕ Treat us to a coffee

Treat us to a coffee

→ Feedback  comment: foundic.org/courses
→ Feedback & comment: foundic.org/courses

foundic.org foundic.org
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